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AnemoScope Tutorial 

Introduction 

In this tutorial, you will perform a complete simulation process and produce wind 
statistics for a 250 000 km2 mesoscale domain in the eastern part of Canada and a 
detailed wind map on a 131.8 km² microscale sub-domain focusing on the Montreal 
region. 
This tutorial deals only with AnemoScope functions and does not cover general EnSim 
capabilities.  In this tutorial, you will be using the modules listed below, which 
correspond to individual steps in the AnemoScope simulation process: 

As you complete the tutorial, you will carry out the two main parts of the AnemoScope 
simulation process: 

• Part 1: Run mesoscale wind simulations and produce wind statistics for the 
mesoscale domain in eastern Canada.  

• Part 2: Run higher resolution microscale simulations and produce a detailed wind 
map for the microscale sub-domain around Montréal. 

Part 1 of the process—producing mesoscale wind statistics—consists of 8 steps: 
1. Import a reference map of the region of interest. 

2.   Open a wind climate database. 

3.   Select a climate table. 

4.   Define the mesoscale domain and the mesoscale grid. 

5.   Generate the geophysical terrain data on the mesoscale grid. 

6.   Set up and launch mesoscale simulations for selected climate states. 

7.   Compute the mesoscale wind statistics data. 

8.   Check the mesoscale wind statistics in the Wind Statistics View. 
Part 2 of the process—producing a microscale wind map—consists of 3 steps: 

1.   Define a high resolution grid to support the microscale terrain data. 

2.   Generate the high resolution geophysical terrain data for the microscale grid. 
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3.   Set up and perform the microscale simulations and compute the microscale 
wind statistics data. 

Part 2 of this process can be performed by itself if mesoscale wind statistics are already 
available from other sources.  For example, you could use data files downloaded from 
the Canadian Wind Energy Atlas at http://www.windatlas.ca. 
We strongly recommend that you complete Part 1 of this tutorial before trying Part 2.  
Because many of the skills used in Part 2 are explained in Part 1, doing the sections out 
of order, or skipping Part 1 entirely, may cause some confusion. 

Benchmark Data 

All the data needed for this tutorial is provided on the tutorial CD provided. Unzip the 
archive to a disk having at least 1.5 GB of free space.  Ensure that the path does not 
contain any spaces.  If you unzip the archive to C:\CHC\Tutorial, the resulting directory 
tree will be structured as follows: 

• Tutorial\InputData - contains the GIS data needed as input for the tutorial. 

• Tutorial\MC2 – contains MC2 simulation results for all wind climate states 
corresponding to Annual wind climate table 55\115_table.ef. 

• Tutorial\MesoGrid - contains files created by the GenGeo module, and used as 
input for the MC2 module. 

• Tutorial\MicroGrid – contains files created by GenGeo, and used as input for the 
MMC module. 

• Tutorial\WEStats - contains the mesoscale wind statistics maps produced by MC2, 
and used in the MMC module. 

• Tutorial\MMC – contains the final results of the MMC module. 

• Tutorial\Settings - contains the benchmark settings files.  You will have the option 
to compare your own settings files produced during the tutorial with these reference 
files.  Ideally, the two should be the same, except for some pathnames. 

• Tutorial\OutputData - contains the benchmark output data. You will have the 
option to compare your own results with these reference output files. 
Note: As you work through the tutorial, the directory C:\CHC\Tutorial will be 
referred to as [TutorialDir].   

Before You Begin 

1. Start by creating a folder called MyTutorial in which all the data you create during 
the tutorial will be stored.  Make sure that the path to this folder, including the name 
of the folder, doesn’t contain any spaces.  The software library used by 
AnemoScope and its subprograms to read and write FST files is not able to deal 
with pathnames containing spaces.  In particular, make sure that the folder isn’t 
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located in your My Documents directory.  Also, be sure that the disk on which you 
create the folder has enough space.  If you follow every step, slightly less than 350 
MB of space will be required. 

2. Open the AnemoScope software from your desktop or from the Start menu.  The 
AnemoScope program window should look something like this: 

The WorkSpace only contains a 2D View, which is open by default.  No data items are 
loaded.  If no 2D View is present, open one using the New 2D View button  on the 
EnSim tool bar. 

Note: When you see the notation “[AnemoScope]” used in the tutorial, it’s intended 
to represent the folder into which AnemoScope was installed.  The default location 
is C:\CHC\AnemoScope. 
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Part 1: MC2 - Mesoscale Wind Statistics Production 

As mentioned in the introduction, this section will teach you how to produce mesoscale 
wind statistics.  By the time you’re finished Part 1, you’ll know how to use AnemoScope, 
the Wind Climate database, and the GenGeo database to produce a map containing a 
wide range of statistical data for a particular region. 
You’ll need to do the steps in order, since each one builds on the results of the previous 
step.  If you get lost, or you’d like to review a particular part of the process, you can use 
the benchmark data from the previous lesson, which is included with AnemoScope.   

Step 1: Import a Map of the Region of Interest 

By the end of this step, you will have imported a map from the MapInfo Interchange File 
format and displayed it in a 2-dimensional view window.  You’ll use this map as a 
reference when choosing how to locate your model grid. 
1. Use the Windows Explorer to create a folder named MyMeso in your MyTutorial 

directory.  Remember, there’s no space between My and Meso. 
2. Import the reference map, which is stored in the MapInfo Interchange File format.  

From the menu bar, select File→Import→MapInfo Interchange File. 
3. Use the Import dialog to select the file Coasts.mif located in 

[TutorialDir]\InputData\Maps\North_America_Atlas10M.  The Coasts.mif object 
will appear in the Data Items list, with the map itself shown as a 2-dimensional line 
set child object. 

4. Within the WorkSpace, drag the line set object (the one with this icon: ) to the 2D 
View.  A hydrological map of North America in Lat/Long coordinates is displayed: 

5. Now, transform the data into the Polar Stereographic coordinate system, which is 
the system used by AnemoScope.  Double-click on the 2-dimensional line set 
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object, or select Properties from the map’s shortcut menu (which you can open by 
right-clicking on the object in the WorkSpace) to open the Properties dialog box and 
select the Spatial tab. 
a) First, change the Projection by expanding the list of available projections and 

selecting Polar Stereographic on the Spatial tab of the Properties dialog. 
b) Set the Centre Longitude value to -100 (i.e., 100° W), which is approximately 

central for Canada.  The Centre Latitude should be left as it is (the default value 
of 60° N).  The Ellipsoid (Datum) should also be left as it is.  The Properties 
window should now look as shown below: 

  

c) Click Apply to confirm your changes.  The map is changed in the 2D View and 
is displayed in the Polar Stereographic projection. 

6. Click OK to close the Properties window.  The map displayed in the 2D window 
should resemble the one shown below.  
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Step 2:   Open the Wind Climate Database 

At the conclusion of this step, you’ll know how to open the Wind Climate Database, 
convert it to Polar Stereographic coordinates, and display the database in a 2-
dimensional view window, along with your reference map. 

1. Click the Load Climate Database button  on the AnemoScope tool bar and 
select the [AnemoScope]\WindClimateDB_Annual  directory in the Browse For 
Folder box.  The Annual wind climate database index file is loaded.  Click OK when 
the loading is finished. 

2. Within the WorkSpace, drag the new point set object  to the 2D 
View.  An error message is displayed.  This error is shown because the wind 
climate database is in Lat/Long coordinates, while the reference map is in the Polar 
Stereographic projection.  Click OK to close the error message. 

3. Double-click the WindClimateDB_Annual point set object within the WorkSpace to 
open its Properties dialog box.  Select the Spatial tab to modify the Coordinate 
System and convert the wind climate database to the same coordinate system as 
the reference map. 
a) First, change the Projection by expanding the list of available projections and 

selecting PolarStereographic.   
b) Set the Centre Longitude value to -100.  The Ellipsoid (Datum) should be left 

as it is.   
c) Click Apply to confirm your changes.  Click OK to close the Properties box. 

4. Drag the WindClimateDB_Annual object to the 2D View again.  The location of 
each wind climate table is shown by a square point superimposed on the map of 
North America. 
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Step 3:   Select a Wind Climate Table 

At the end of this section, you will have selected a wind climate table from those in or 
near your region of interest.  The data from this climate table will be used in several of 
the later steps to provide information on wind conditions that have been observed in the 
region. 
1. Import the Cities.mif  file, and then convert its point set to Polar Stereographic 

coordinates, as described in Step 1.  This file is located in 
[TutorialDir]\InputData\Maps\North_America_Atlas10M. 

2. This file contains a set of points with 6 different attributes.  We only want to display 
one of these attributes: city names.  Within the WorkSpace, double-click on 

, or select Properties from its shortcut menu (by right-clicking on its 
name) to open the Properties dialog box. 

3. Select the Data tab.  The UIDENT attribute is selected.  Click on the NAME 
attribute.  Click Apply.  Switch to the Display tab and check the Show Node Label 
box. Click OK. 

4. Center the view on the Montreal Region.  Zoom in (<Ctrl>+left mouse button and 
drag upwards, or scroll up with your mouse wheel) and move (drag with the left 
mouse button). 

5. Increase the size of the square points representing the climate table locations.  
Double-click the WindClimateDB_Annual point set object within the WorkSpace to 
open its Properties dialog box.  In the Display tab, increase the Point Size value 
to 10 using the up arrow.  Confirm your changes with Apply.  Click OK to close the 
Properties box. 

6. We will select table 55\115, which is the closest to the Montreal region.  Zoom in 
until the view looks like the above image.  This location of this table is just 
northwest of Montreal, next to Joliette.  It is circled in the picture above.  Double-
click on the square point.   
If you can’t select the point, make sure that the WindClimateDB_Annual object is 
the currently selected object in the WorkSpace panel.  When you’ve double-clicked 
on the point, an information box will be displayed.  Its last line indicates the name of 
the table.  Make sure you have selected File: 55\115_table.ef.  If you clicked on the 
wrong point, make your selection again.  You should see the popup display shown 
below.  
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7. When 55\115_table.ef is selected, load the table with the Load Climate Table 
button  on the AnemoScope tool bar or right click to show the context menu and 
select "Load Wind Climate Table".  A Table child object will be added in the 
WorkSpace to the WindClimateDB_Annual point set object: 

Step 4:  Define a Mesoscale Grid 

 and described a regular grid that will later 

r Grid button 

By the end of this step, you will have created
be used by GenGeo to define the mesoscale terrain features and by MC2 to calculate 
the mesoscale wind map. 

1. Click the New Regula  on the AnemoScope tool bar.  An empty 
Regular Grid object, with the icon , i

2. 
coordinates of the Origin of the grid (the lower left corner), the Count (the number 

s added to the Data Items list, and its 
Properties dialog pops up.  It opens on the GridGen tab, which is initially empty. 

To create a grid approximately centred on Montreal we have to specify the 
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of cells in each direction), and the cell size Delta.   
In the 2D View, you can see that the Montreal point is roughly located at  
X = 2159000 and Y = -4355000. 
In the Specification frame of this tab, enter the following values: 

• Origin: X= 1880000.0; Y= -4560000.0 

• Count: X= 100; Y=100 

• Delta: X= 5000; Y= 5000 (These values are in metres.) 
ual.  If you would like 

ure that the X and Y 

• rt 

c ’s icon changes to

Note: The Delta X and Delta Y values must always be eq
to experiment with different Delta values, always make s
values are the same. 

Angle: 0 (This angle should always be 0, since the FST format doesn’t suppo
rotated grids.) 

• Def. Value: 0 (This value will be overwritten by GenGeo.) 
Cli k Initialize to create the grid.  Note that the new grid object   
in t e Data Items list. h

3. 
.  Click the Assign… button and select the following 

4. Click OK to confirm. 
to the 2D View within the WorkSpace.  Zoom in 

tton and drag upwards, or scroll up with your mouse wheel).  

Switch to the Spatial tab of the Properties box in order to assign a coordinate 
system to this new grid
parameters: 

5. Drag the new grid object 
(<Ctrl>+left mouse bu
The 2D view window should now look something like the picture below. 
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6. If the grid looks good, click OK to close the Properties box.  If your grid doesn’t look 
like the one pictured, double-check the numbers in the GridGen tab, and make sure 
that you used the correct Centre Latitude and Longitude values on the Spatial tab. 

7. Make sure that the new Regular Grid object is selected in the WorkSpace and click 
the Save File button  on the EnSim tool bar to save the grid in EnSim .r2s format. 
Save the grid as MyMesoGrid.r2s in your MyTutorial\MyMeso folder.  

8. Export the grid to FST format by clicking the Save As FST button  on the 
AnemoScope tool bar.  Save the grid as MyMesoGrid.fst in your 
MyTutorial\MyMeso folder. 

After you click Save, a message box will appear, asking you to enter a valid FST 
field name.  Enter GRID, indicating that this grid will contain no data, but only a grid 
definition.  Click OK. 

If the export fails: 

The export procedure will fail if the path to your grid file contains any spaces.  
In this case, check the location and the name of your MyTutorial and MyMeso folders.  If 
their locations contain any spaces in their paths (for example,  if they’re in your My 
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Documents folder) then you will have to copy the directories to appropriate locations.  If 
you used a space in either of the folder names, you’ll have to rename the folders.  
If one of the directories was just accessed by AnemoScope, you won’t be able to copy 
the folders right away.  AnemoScope keeps a link to the most recent folder used.  To 
deactivate the folder, open a file located outside your MyTutorial folder.  

Save Your WorkSpace 

At this point, it may be useful to save your WorkSpace by selecting File→Save 
WorkSpace… from the menu bar.  Save your WorkSpace as MyWorkSpace1 in your 
MyTutorial\MyMeso folder.  It will be saved as an EnSim WorkSpace File (*.ews).  This 
way, your AnemoScope session can be ended and restarted at a later time.  However, 
note that any coordinate system settings Assigned or Applied to data items are not 
saved and will not be restored.  You will have to perform them again when the 
WorkSpace is reloaded, if you need to repeat any of the earlier steps. 

Step 5:  Generate Geophysical Terrain Data for the Mesoscale Grid 

When you’ve finished this step, you will have created a mesoscale terrain grid, including 
topographical and vegetation data, which will be used by MC2 to create the mesoscale 
wind map. 

1. Click the New GenGeo Parameters button  on the AnemoScope tool bar.  A new 
GenGeo parameter file object is added to the WorkSpace Data Items list and its 
Editor/Property Page pops up.   

2. Grid File (tape1): use the Browse button  to select the mesoscale FST grid file 
MyMesoGrid.fst from your MyTutorial\MyMeso folder. 

3. DataBase Directories:  
a) Default: use the Browse button  to select the GenGeoDB directory.  The 

GenGeo database is provided with the software distribution as an archive file 
named Gengeo.zip.  You’ll have to select the GenGeoDB directory at the 
location to which you extracted it from the archive when you installed 
AnemoScope.  

b) Topo Dir: leave this entry blank. This time around, the Default Directory will be 
used as Topo Dir. 

c) Veg Dir: leave this entry blank. The Default Directory will also be used as the 
Vegetation Directory. 
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4. Options and Filters: keep the default parameters. 
5. Run Options: check the  Write log file box to record a log file.  Set the verbose 

level to 4 to get the maximum level of information. 
6. Click Apply to confirm your settings. 

7. Output File (Geophy): use the Browse button  to go to your 
MyTutorial\MyMeso folder.  In the File Name box type MyMesoGeo.  The Save 
as type box should say FST file (*.fst).  Click Save when you’re done. 

8. Click the Run GenGeo button to launch the GenGeo program execution. 
9. You are asked to specify the namelist file in which the input parameters will be 

stored.  Type MyMesoGeo in the File Name box.  The Save as type box indicates 
GenGeo Parameter Set (*.nml).  Click Save when done. 

10. When the execution starts, a DOS Window will open.  Success and error messages 
are displayed in this window.  If an error occurs, it may be an indication that your 
settings are not correct.  Make sure you entered the right information in the 
Namelist File Editor dialog.  When the calculations are complete, which may take as 
long as 90 seconds, depending on your machine, press <Enter> to close the 
window.  

11. After a successful execution, click OK to close the GenGeo Namelist File editor.  
12. Using the Windows Explorer, open the GenGeo.log file in your MyTutorial\MyMeso 
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folder.  It can be viewed in Notepad or any other text editor.  The file should not 
contain any error messages and the Data Coverage values should reach 100% for 
all the fields processed.  You can also compare it with the example file located in 
TutorialDir]\MesoGrid\GenGeo.log.  Except for the path definitions, they should 
be similar. 

13. Click the Show FST File Catalog button  on the AnemoScope tool bar to see the 
catalog of your MyMesoGeo.fst file.  Select the file in your MyTutorial\MyMeso 
folder and click Open to view it.  The contents of the file will be displayed in table 
format: 

14. The GenGeo output can also be visualized in a 2D view.  Click the Open File 
button  on the EnSim tool bar.  Set Files of type to FST File (*.fst), and select 
and Open your MyMesoGeo.fst file.  

15. Select the MG (land/water mask) field (not MG0) by checking the box in front of its 
name.  Click OK to load the file, and again when the loading is complete. 

16. Within the WorkSpace, drag the regular grid object MG to the 2D View.  MG 
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appears as a child of the FST object MyMesoGeo.  The MG field is displayed in 
wireframe mode by default.  The blue regions are water regions.  The St. Lawrence 
river is clearly visible. 

Validation of Your GenGeo Results  

We will now compare your results with the benchmark results.  
1. Click the Open File button  on the EnSim tool bar.  Set Files of type as FST File 

(*.fst).  Select and Open the file [TutorialDir]\MesoGrid\MesoGeophy.fst.  Select 
the MG field and click OK.  

2. You have now two MG regular grid objects open.  In order to avoid confusion, we’ll 
change the name of the benchmark grid.  Double-click the MG object child of 
MesoGeophy to open its Properties dialog.  Switch to the Meta Data tab. 

3. The second line is “Name MG”.  Click on MG and replace the value with  
MG-bench.  Click Apply and OK.  The object name will change in the WorkSpace. 

4. Within the WorkSpace, drag the regular grid object MG-bench to the 2D View.  
There should be no visible difference between the two grids. 

5. We will now compare the two results quantitatively by creating an object that will 
show any differences between the two grids:   

a) Select the MG-bench object in the WorkSpace. Click the Calculator button  
on the EnSim tool bar. 

b) In the A box, select MG, using the down arrow to expand the list of fields.   
c) In the B box, select MG-bench.   
d) In the Expression box, type A-B .   
e) In the Result box, type the Name of the resulting field, MG-diff.  Leave the 

Units box blank.  
f) Click Evaluate. 

6. The regular grid object MG-diff is added to the WorkSpace.  Drag this object to a 
2D View.  It is displayed in wireframe mode and should be entirely red, indicating 
that there is no difference between the fields. Open the Properties dialog for the 
MG-diff object. Select the Data tab and note that the Min and Max values should 
both be 0 

7. Click the Active Cursor button  on the EnSim tool bar.  Move the mouse over the 
grid in the 2D View.  The cursor should display a value of 0.000 everywhere on the 
grid.  Deactivate the Active Cursor by pressing <Esc>. 

8. If your results don’t match, check all of your previous steps.  In particular, check 
your GenGeo dialog entries against the example shown earlier.  If the entries are 
the same, remove the MG-bench FST object from the WorkSpace by right-clicking 
on it and selecting remove.  Answer No to the question “Would you like to save the 
changes?”.  Remove the MG-diff regular grid object the same way. 
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Step 6:  Set Up and Perform the Mesoscale Simulations 

After this step, you will have configured and run the MC2 module, which combines the 
mesoscale terrain grid you created in Step 5 with the climate information found in the 
Wind Climate database to create a series of wind maps for each of the climate states.  
These maps are then combined by the WEStats module to create the mesoscale wind 
statistics map. 
1. Using the Windows Explorer, create a new folder named MyMesoSimu inside your 

MyTutorial\MyMeso folder.  Remember, there should be no spaces in the folder 
name. 

2. Click the New MC2 Parameters button  on the AnemoScope tool bar.  The MC2 
Parameter File Editor pops up.  In addition, a new MC2 parameter file object is 
added to the Data Items list in the WorkSpace.  This object has two child objects 
which are empty at this stage. 
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3. First, fill out the Simulation panel: 
a) Run Directory: Use the Browse button  to select your MyMesoSimu folder.  

All the outputs produced by the MC2 simulations will be placed in this folder.  
b) Temporal: Keep the default values for the time step Delta T (120 s), the 

number of time steps Total Steps (270) and the Output Freq. (270).   They are 
well suited for our 5 km resolution map of the Montreal region, which presents 
only a moderate topography.  

c) MC2/EOLE options: Keep the default values for the number of Vertical 
Layers (28), the number of Levels in 0-1500m (10), and Topo Change Steps 
(29).   

d) Process Parameters: Leave the Use Condor box unchecked.  The runs will 
be performed interactively, using only your computer. All the Condor entries will 
be greyed out. Check the  Write log file option, which will store the run 
information in a log file. Check the  Cleanup Intermediate Files option, 
which will delete the intermediate results. 

e) Click Apply to confirm the settings.  If you don’t apply the settings before 
switching to another tab, any changes you’ve made will be lost. 

4. Click the Climate States tab to move to the Climate States panel. 
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a) Table name: Click on the down arrow to expand the list of the tables currently 
available in the WorkSpace.  Only table 55\115 should be available.  Select it.  
If the table is not listed, repeat Step 3: Select a Wind Climate Table. 

b) The contents of the climate table are displayed in two columns.  On the left 
side, the climate states of the table are listed.  On the right side, the parameters 
of the highlighted climate state are shown.  Click on a climate state to highlight 
it and display its parameters.  

c) To generate accurate mesoscale wind statistics, you’ll have to perform one 
mesoscale simulation for each of the climate states.  In this case, that would be 
360 simulations.  For this tutorial, we will perform only three simulations.  Select 
the first climate state (ANU1D000C10M), the second state (ANU1D000C12M), 
and the fourth state (ANU1D338C10M) by clicking their checkboxes.  

5. Click Apply again to confirm your selections. 
6. Click the Geophy tab to switch to the Geophy panel.  

a) Use the Browse button  to select the MyMesoGeo.fst file that you created in 
Step 5.  The grille (Grid) parameters are shown in the panel.   

b) Click Apply to confirm.  Notice that in the WorkSpace, the two child objects of 
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the MC2 parameter file object are now defined. 
7. Go back to the Simulation panel and double-check your entries.  Notice that the 

Courant Number field is now filled in.   
8. When you’re done double-checking, click the Prepare Runs button.  If any error or 

warning messages appear, double-check your settings again.  You will then be 
asked to specify the file in which the MC2 input parameters will be stored.  Save 
this file as MyMesoMC2.mc2 in your MyTutorial\MyMeso folder.  The file structure 
required for the MC2 simulations is automatically prepared in your MyMesoSimu 
folder; three folders (one for each climate state) and a Python script which will 
launch the simulations are created. 

Note: Running the MC2 modules can take a very long time, depending on the 
speed of your computer.  On a typical Pentium 4 computer, running three 
simulations will take about 90 minutes.  Running the complete set of 
simulations for the 360 climate states would take about a week.  If you would 
prefer to skip this step, just read the following instructions and continue on with 
the benchmark data. 

9. Click the Run… button to launch the MC2 simulations.  Answer Yes to the question 
to confirm that you want to launch the simulation.  A DOS Window pops up.  The 
progress of the simulation is displayed in this window.  At the end of the execution, 
press <Enter> to close this window.  

10. After a successful execution, click OK to close the MC2 Namelist File Editor.  If any 
errors have occurred, recheck your settings and launch the simulation again after 
making any corrections.   

11. Whether you still have errors or you’ve successfully run the MC2 module, it’s a 
good idea to check your results. 
a) In the Windows Explorer, go to your MyMesoSimu folder.  Three subfolders 

were created, one for each simulated case.  Their names are the identifiers of 
the climate state: ANU1D000C10M, ANU1D000C12M, and ANU1D338C10M.  
Open the ANU1D000C10M folder. 

b) Check the status.dot file by opening it with a text editor, such as Notepad.  It 
should contain the following lines:  

_status=ABORT;_startstep=0000000000;                                           
_endstep=0000000270;                                                           
_status=ED; 

If you don’t see all of these lines, turn on Word Wrap under the Format menu in 
Notepad. 

c) Open the pre-processor log file (ANU1D000C10M _mc2ntr.log) for a quick 
check.  Look for the line  

MC2NTR ENDED NORMALLY 

close to the end of the file.  
d) Open the log file of the simulation (ANU1D000C10M _mc2dm.log) for a quick 
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check. Look for the line  
MC2DM RUN ENDED NORMALLY 

close to the end of the file.  Also, check all the lines that have a MAX COURANT 
NUMBER entry.  The values should not exceed 1, indicating that the simulation 
is stable.  A value of 0.4 is considered ideal. The maximum value reached in 
this simulation is 0.8618066 , which is fairly high, but within acceptable 
parameters. 

e) The results of the individual MC2 simulations can also be examined to detect 
possible problems.   Click the Open File button  on the EnSim tool bar.   Set 
Files of type to FST File (*.fst), and Open the file dm1998010100-00-
00_000270p.fst in your 
MyTutorial\MyMeso\MyMesoSimu\ANU1D000C10M\output\ folder.  This is 
the output of your last time step. 

f) Select the P0 (ground pressure) field by checking the box in front of its name.  
Click OK. 

g) Within the WorkSpace, drag the regular grid object P0 (shown as a child of 
dm1998010100-00-00_000270p) to a 2D View.   By default, the P0 field is 
displayed in wireframe mode.  Open its Properties dialog, go to the Display 
tab and select Filled Contours as the Rendering Style.  It should look like the 
example below.  Note that the first grid cell row and column are not used by the 
dynamic fields. 

Validation of Your MC2 Results 

Now we’ll compare your results with the benchmark results.  
1. Click the Open File button  on the EnSim tool bar.  Set Files of type to FST File 

(*.fst), and Open the [TutorialDir]\MC2\Output\ 
ANU1D000C10M\m1998010100-00-00_000270p.fst file.  Select the P0 field.  
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2. You have now two dm1998010100-00-00_000270p  and two P0 regular grid 
objects in your WorkSpace.  In order to avoid confusion we will change the names 
of the benchmark data.  Double-click on the second dm1998010100-00-
00_000270p object on the Data Items list to open its Properties dialog box.  In the 
Meta Data tab, click on the name value and replace it with dm-bench.  Click Apply 
and OK when satisfied.  Notice that the object name changes in the WorkSpace. 

3. Double-click on the P0 object child of dm-bench to open its Properties dialog box.  
Switch to the Meta Data tab.  Replace “P0” with “P0-bench”.  Click Apply and OK 
when you’re finished.  Note that the object name is changed in the WorkSpace. 

4. Within the WorkSpace, drag and drop the regular grid object P0-bench in the 2D 
View.  There should be no difference between the two objects. 

5. We will now compare the two results quantitatively.   

a) Click the Calculator button  on the EnSim tool bar.  If the button is not active, 
select the P0-bench object in the WorkSpace.   

b) As the A entry, select P0, using the down arrow to expand the list of available 
fields.   

c) As the B entry, select P0-bench.   
d) In the Expression box, type A-B .   
e) In the Result box, type the name for the resulting field, P0-diff.  Do not specify 

any units.   
f) Click Evaluate. 

6. The regular grid object P0-diff is added to the WorkSpace.  Drag this object into the 
2D View.  It is displayed in wireframe mode and should be completely red (to see it 
better, remove the P0 object from the 2D View). 

7. Click the Active Cursor button  on the EnSim tool bar.  Move the mouse over the 
grid in the 2D View.  The cursor should display a value of 0.000 everywhere.  
Deactivate the Active Cursor by pressing <Esc>. 

8. If the two grids don’t match, double-check your settings.  In particular, check your 
MC2 dialog entries against the examples shown earlier.  You can also compare 
ANU1D000C10M_mc2ntr.log and ANU1D000C10M_mc2dm.log  with the 
benchmark log files provided in [TutorialDir]\MC2\Output\ANU1D000C10M\ 

9. If you’re finished with the comparisons, remove the dm-bench object from the 
WorkSpace by opening its shortcut menu and selecting Remove.  Answer No to 
the question “Would you like to save the changes?”.  Remove the P0-diff regular 
grid object the same way. 
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Step 7:  Compute the Mesoscale Wind Statistics Data 

When you’re finished this step, you’ll have created a mesoscale wind energy statistics 
map from individual climate state wind maps created by the MC2 model.   
In the previous steps you performed mesoscale simulations for only three climate 
states.  In order to be representative, the wind statistics must be computed for a broad 
range of climate states.  To save you from having to perform the hundreds of MC2 
simulations required, the Tutorial directory [TutorialDir]\MC2\55_115\ contains the MC2 
simulation results for the entire set of Climate States corresponding to table 55\115. 

1. Click the New WEStats Parameters button  on the AnemoScope tool bar.   The 
WEStats Namelist File Editor appears.   In addition, a new WEStats namelist file 
object is added to the Data Items list in the WorkSpace. Complete the editor as 
follows:  

2. MC2 Model Data Directory: Use the Browse button  to select the 
[TutorialDir]\MC2\55_115\  directory.  All of the simulations (360) available in this 
directory are listed in the frame below, identified by the name of the climate state.  
The results of these simulations will be processed to define the mesoscale wind 
statistics. 
a) Dynamics Time Step #: Set this value to 260 and click Apply.  Note that the 
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Level [m]/[ip1] box below remains grey and does not list any choices.  This is 
because the time step number 260 is not recorded in the output files.   
Change the Dynamics Time Step # to 270, which was the final time step of the 
mesoscale simulations, and notice that the Level [m]/[ip1] box becomes active.  
The statistics will be computed using the results at this time step.  

b) Level [m]/[ip1]: Select the 50/(12011) Statistics Level in the list of available 
levels.  This grid level will be used to interpolate the wind fields at the Statistics 
level. 

3. Meso Geophy: Use the Browse button  to select the mesoscale geophysical 
data file you generated with GenGeo (MyMesoGeo.fst). 

4. Wind Climate Table: Use the Browse button  to select the climate table used for 
the mesoscale simulation, 55\115_table.ef, which is located at 
[AnemoScope]\WindClimateDB_Annual\55\115_table.ef. 

5. Fill in the Options area as follows: 
a) Statistics level: Leave this as 50.  This is the height above ground level for 

which the statistics will be computed, in metres. 
b) Max Wind Speed: Do not change the default value of 25 (m/s).  This is the 

wind speed above which all the values are considered to be in a single wind 
speed class. 

c) Averaging length: Do not change the default value of 1, which means that 
some quantities will be smoothed using a local average over a 3×3 cell area. 

d) Leave the Delete intermediate UV File option checked in order to remove all 
intermediate output files. 

6. Output File (Statistics): Name your output file MyMesoStats.fst and place it in 
MyTutorial\MyMeso.  

7. Click RunWEStats to launch the computations.  Before the execution starts, specify 
the namelist file in which the WEStats input parameters will be stored.  Save this file 
as MyMesoStats.nml in your MyTutorial\MyMeso folder.  

8. A Running WEStats… window pops up in which information on the execution is 
displayed.  Click OK when it finishes.  This process can take as long as several 
minutes to complete. 

9. When the computation is completed, close the WEStats Namelist File Editor dialog 
by clicking OK. 

Step 8:  Check the Mesoscale Wind Statistics in the Wind Statistics View. 
When you’ve closed the Namelist File Editor dialog, use the Wind Statistics View to 
examine your results.  The Wind Statistics View is specifically designed to allow you to 
examine any point on any field of the wind statistics file, while generating a wind rose 
and a wind speed histogram for the location. 
1. Open a new Wind Statistics View by clicking the New Wind Statistics View 
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button  on the AnemoScope tool bar.  This view is specifically designed to 
visualize the wind statistics data.  

2. Click the Open File button  on the EnSim tool bar.  Set Files of type to FST File 
(*.fst), and open your MyMesoStats.fst statistics file.  Select all of the fields by 
clicking All On.  Click OK. 

3. Within the WorkSpace, drag the regular grid object ER (a child of MyMesoStats) 
into the Wind Statistics View.  You should see a 2D map displayed on the right-
hand side of the view.  Double-click on any point on the map.  This will cause a 
wind rose to appear on the left-hand side of the view.  The variable ER contains the 
frequency distribution of wind direction by sector.  By default, sector 1, centered 
around 0°, is active, so the frequency of wind in this sector is what’s being shown 
on the map.  You can select another sector by using the Data tab of the ER object’s 
Properties dialog.  Note that the wind rose shows information for all 12 sectors at 
once. 

4. Within the WorkSpace, drag the regular grid object UH (also a child of 
MyMesoStats) into the Wind Statistics View.  The new map is displayed on the 
right-hand side of the view.  Double-click on any point on the map; in addition to the 
wind rose,  a wind speed histogram will appear on the left-hand side of the view.  
The variable UH is the frequency distribution of wind speed by class.  By default, 
class 1, 0 to 0.2 m/s, is active but you can select another class on the Data tab of 
the UH object’s Properties dialog.  The wind speed histogram show values for all 27 
categories at once. 

5. You can now drag and drop any other field from MyMesoStats into the Wind 
Statistics View.  It will be displayed in the right-hand frame.  Double-clicking 
anywhere on the map will display wind roses and wind speed histograms based on 
the ER and UH fields.  Try it out by displaying the EU field (which shows the mean 
wind speed) and selecting a few locations. 

Validation of Your WEStats Results 

Now we’ll compare your results with the benchmark results.  
1. First, compare your map of the EU field with the example below. 
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2. Then drag the Cities point set object to the Wind Statistics View.  Zoom in and 
center the view on Montreal.  Double-click on the grid point located just northeast of 
Montreal (Node 4116, located at I=57, J=42). The wind rose and the wind speed 
histogram should look like the following example (each frame of the Wind Statistics 
View has it own zooming capability):  

3. For a quantitative comparison, load the reference WEStats output file 
MesoStats.fst located in  [TutorialDir]\WEStats\  and compare them with the 
calculator, like you did with your GenGeo and MC2 results.   
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Part 2: MMC - Microscale Wind Statistics Production 

Note: You should not try this part of the tutorial until you’re familiar with the topics 
covered in Part 1. 
When exploring the MMC module, we’ll use the MsMicro microscale wind model to 
compute wind flow in the lower part of the atmospheric boundary layer, between 10 m 
and 150 m above ground.  The calculation is done on a fine grid; here we’ll use a grid 
with a resolution of 200 m.  As was the case for the mesoscale model, the coordinate 
system used is Polar Stereographic, with a spherical ellipsoid. 
The target microscale area is Montreal and its surroundings. 
MsMicro needs three inputs, in addition to the parameter settings: 

• Wind data:  We get this from the mesoscale gridded statistics generated by 
WEStats on the basis of the MC2 results. 

• Topographic elevation.  This should be at approximately the same resolution as 
the microscale grid, about 200 m.  In most cases, you’ll need to supply this 
information, since the GenGeo database, although covering the entire surface of 
the Earth, is limited in resolution to about 1 km. 

• Detailed land cover.  This should also be at about the same resolution as the 
microscale grid.  Like the topographical data, you’ll need to supply this data. 

For the Tutorial MMC exercise, we provide the wind data and a high resolution 
topographic elevation database, but not the detailed land cover database.  So, for land 
cover, we’ll use the GenGeo database, which isn’t really accurate enough for the best 
possible results.  This will cause minor patchwork patterns, with a 1-km footprint in 
some parts of the solution, as well as slight inaccuracies in the land-water boundaries 
that you’ll be able to see in the microscale wind pattern obtained.  With more precise 
data, these problems can be avoided. 
The MMC tutorial data is organized as follows: 

• [TutorialDir]\InputData\Maps\Montreal\Water.mif - contains a high resolution 
(1:250k) coastline for the Montreal area in MIF format, in Lat/Long coordinates with 
a Spherical datum.  

• [TutorialDir]\InputData\Dem\Montreal.arc - contains a high resolution (1:250k) 
terrain model for the Montreal area, in ArcInfo ASCII grid format. 

• [TutorialDir]\MicroGrid - contains settings and results of the microscale grid 
preparation process. 

• [TutorialDir]\MMC - contains the reference settings and results for the microscale 
model. 

 
Before you begin, use the Windows Explorer to create a new folder called MyMicro 
inside your MyTutorial directory.  Remember, there should be no spaces in this folder 
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names. 
There are two more things that you’ll have to do before you begin to create the 
microscale terrain map.  Because the GenGeoDB only has a resolution of about 1 km, 
more precise geographical data must be used.  For GenGeo to understand the data, it 
first has to be converted into FST format. 

Importing High Resolution Topography 

AnemoScope includes support for various DEM (Digital Elevation Map) data formats 
including ArcINFO ASCII Grid, CDED/DTED and Surfer. The high resolution DEM 
supplied with this tutorial is in ArcINFO ASCII Grid format. 
 
1. Using the Windows Explorer, create a new folder called MyTopodb inside your 

MyTutorial\MyMicro folder.  Remember, there are no spaces in the folder name. 
2. Launch AnemoScope from your desktop or from the Start menu, if it’s not already 

running. 
3. Let's take a look at our DEM data.   From the menu bar, select 

File→Import→ArcINFO Grid (ASCII) to import the Montreal.arc file from 
[TutorialDir]\ InputData\Dem.  The DEM characteristics are displayed in the pop 
up window: 
d) ncols, nrows:          2402  3602 
e) xllcorner, yllcorner:  -75.000583  43.998936 
f) cellsize:     0.000833  degrees. 

4. This DEM was defined in the Lat/Long reference system, with a spherical ellipsoid 
but since this information is not stored in ArcINFO ASCII Grid files you must use 
the Spatial tab of its Properties dialog to Assign the Lat/Long coordinate system, 
with a spherical ellipsoid.  Drag it to your 2D view.  

5. Export the DEM to FST format by clicking the Save as FST button  on the 
AnemoScope tool bar.  Save it as MyTOPODB_ME.fst under your 
MyTutorial\MyMicro\MyTopodb folder.   

6. Once you’ve clicked Save, you’ll be asked to provide a valid FST field name.  Enter 
ME and click OK.  GenGeo reads data from FST files, so this translation will make 
the grid usable as a topographical database. 
Note: Because this file is used only as a source of information, and it isn’t altered 
by AnemoScope when it’s accessed, it’s not necessary to convert the file to the 
Polar Stereographic reference system. 

High Resolution Coastlines 

Next we will load a high resolution map for our area of interest. 
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1. From the menu, select File→Import→MapInfo Interchange File and select the file 
Water.mif from [TutorialDir]\InputData\Maps\Montreal.  

2. This data is also defined with Lat/Long coordinates on a spherical ellipsoid so you 
must change the coordinate system to Polar Stereo (60,-100).   

3. In the WorkSpace, drag the coastline object to the 2D view.  Locate Montreal Island 
on the map. 

4. Click the Open File button  on the EnSim tool bar.  Set Files of type to FST File 
(*.fst), select your MyTutorial\MyMeso folder, and open your MyMesoStats.fst 
mesoscale wind statistics file.  Select the EU field only.  Drag the EU object in the 
2D View. 

5. Open your MyTOPODB_ME.fst topographic file.  Using the Spatial tab on its 
Property Dialog, change the projection to Polar Stereographic (60,-100).  In the 
WorkSpace, drag the ME object to the 2D View. 

6. Reorder the objects in the 2D View.  Within the WorkSpace, drag the EU object and 
the Water objects to the 2D view so that they’re listed in the following order: 

You are now ready to perform the three steps of the process to compute microscale 
wind statistics. 

Step 1:   Define a High-resolution Grid to Support the Microscale 
Terrain Data 

When you’ve finished this step, you will have created a second terrain grid with 
GenGeo, although at a considerably finer resolution than your mesoscale grid.  This 
terrain grid will be used by MMC, along with your mesoscale wind statistics map, to 
create the microscale wind map. 
1. We have to create a grid in Polar Stereographic coordinates that GenGeo can use 

as a target grid to prepare the MsMicro topography and Land Use data.  To make 
best use of our DEM data we have to generate the largest grid that fits inside the 
DEM.  In this case, the grid will have a resolution of 200 m.  The ideal size of this 
grid is shown by the MicroScaleGridPerimeter.i2s file available in the 
[TutorialDir]\InputData\Maps folder.  Open it and overlay it in the view. This is a 
native EnSim i2s file and is already in Polar Stereographic coordinates.   

2. On the Display tab of the Properties dialog, increase the Line Width of the 
MicroScaleGridPerimeter object to 3. 

3. Using the MicroScaleGridPerimeter as a boundary, create a 200 m grid that fits to 
the nearest kilometre.   
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a) Click the New Regular Grid button  on the AnemoScope tool bar.  An empty 
Regular Grid object, with the icon , is added to the Data Items list, and its 
Properties dialog pops up.  It opens on the GridGen tab, which is initially 
empty. 

b) In the WorkSpace, drag the MicroScaleGridPerimeter line object and drop it 
onto the Regular Grid object.  The GridGen tab is automatically filled.  Initialize 
the grid. 

c) Switch to the Spatial tab and Assign the Polar Stereographic (60,-100) 
coordinate system to this new grid.  Go back to the GridGen tab. 

d) In the WorkSpace, drag the new Regular Grid object to the 2D View.  It fits 
within the MicroScaleGridPerimeter outline, but the Delta values are much too 
large. Set Delta X= 200 and Y= 200 and adjust the X and Y counts to Count X= 
670 and Y= 510.  Click Initialize to update the grid computations.   
Note that with the new Delta and Count values, the grid is slightly smaller than 
the perimeter file along the top and right-hand edges. 

4. Use the Save button  to save your grid as MyMicroGrid.r2s in your 
MyTutorial\MyMicro folder.   

5. Click the Save as FST File button  to export it as MyMicroGrid.fst in the same 
folder.  Enter GRID when you’re asked for the FST field name. 
You now have an FST file that covers the entire area that will be examined on the 
microscale level, at a fine resolution. 
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Step 2:  Generate the High-resolution Geophysical Terrain Data for 
the Microscale Grid. 

1. On the AnemoScope tool bar, click the New GenGeo Parameters button  to 
create a new GenGeo parameter file object. 

2. Grid File (tape1): select your MyMicroGrid.fst microscale grid file. 
3. Fill in the DataBase Directories parameters. 

a) Default: select the [GenGeoDB] directory, which was previously extracted 
from Gengeo.zip.  

b) Topo Dir: select the MyTutorial\MyMicro\MyTopodb folder that contains the 
MyTOPODB_ME.fst high resolution topographic database you created earlier.  

c) Veg Dir: leave this entry blank. GenGeo will use the land cover information 
from the default database. 

4. Options and Filters: do not modify these values.  Keep the default parameters. 
5. Check the Write log file box and keep the verbose value at 0 (least feedback).  

Click Apply to confirm your settings. 
6. Output File (Geophy): save your output file in MyTutorial\MyMicro and name it 

MyMicroGEO.fst 
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7. .  When you’re prompted, call the namelist file 

8. finished, which should take a few minutes, open your 
iew. 

9. ith 

10. 

Save Your WorkSpace

Click Run GenGeo
MyMicroGEO.nml. 
When the module is 
MyMicroGEO.fst file and select the ME and MG fields.  Drag MG into the v
Move the coastline Water to the top of the 2D View list.  Compare your results w
the following: 

The DEM object MyTOPODB_ME is no longer necessary.  Open its shortcut 
menu and Remove it from the WorkSpace. 

 

r WorkSpace by selecting File→Save WorkSpace… from 

Step 3: 

Before you go on, save you
the menu bar.  Save your WorkSpace as MyWorkSpace2 in your MyTutorial\MyMicro 
folder.   

 Set Up and Perform the Microscale Simulations and 
Compute the Microscale Wind Statistics Data. 

1. In the WorkSpace, drag EU to the top of the 2D View.  To make it easier to see on 
top of the other maps, make EU a black monochrome wireframe.  Check 
Monochrome in the Display tab of the EU object’s Properties dialog and select 
black from the available colours. 
Click the 2. New MMC Parameters button  on the AnemoScope tool bar.  A 

or 

3. iles are MyMicroGEO.fst (MicroGeophy)  and the 

newMMC object appears in the WorkSpace, and the MMC Namelist File Edit
dialog opens.   
The two Input F
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MyMesoStats.fst (MesoStats).  Select them for your MyMicro and M
options, respectively.  The MesoDX and Stats Elevation boxes are automatic
filled with the data found in the mesoscale statistics file.   
In the 

yMeso 
ally 

4. efault value (1).  We’ll 

5. 
e at 128.  This value defines the number 

b)  Apply.  Notice that the Micro DX, 

6. Retu e are the sweep 
e grid 

 

Sweep Options, keep the Stride parameter at its d
come back to the (I1,J1) and (I2,J2) entries in a moment. 
Start setting the MSMicro Grid options.   
a) Keep the default Tile Size (or nu) valu

of grid points used for each microscale tile.   
Increase the Tile Overlap value to 0.6.  Click
the resolution of the microscale grid, is modified.  The Micro DX should now be 
192.308 m, which is fairly close to the 200 m objective. 
rning to the Sweep Options, the next things to determin

indices: I1, I2, J1, and J2.  These options determine the area of the mesoscal
on which MsMicro will center its individual microgrid domains.  The rule here is to 
keep a "microframe border" around the chosen I and J values to accommodate the
outermost microgrid domains.  

  
 

This microframe border is nu×0.8×MicroDx wide on each side, which in this case is 

e closest to the lower left 
t 

2) is  

128×0.8×192.308 = 19,692 m.  This is 3.94 times the resolution of the Mesoscale 
grid, as shown in the Meso DX box.   So, we need to keep a 4 Meso Delta 
microframe border around the (I1, J1)/(I2, J2) domain.  
Within the view window, click on the mesoscale grid nod
corner of the microscale geophysical data, but still within the microscale grid, to ge
the mesoscale node indices.  Do the same for the upper right corner.  We find that 
the corners are at (37, 30) and (62,49) respectively. 
So, the smallest choice possible for (I1,J1) is  
I1 = 37 + 4 = 41 and J1 = 30 + 4 = 34  
and the largest choice possible for (I2,J
I2 = 62 – 4 = 58 and J2 = 49 – 4 = 45. 
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Enter the final values: (41, 34) and (58, 45). 
7. Leave the Output Variables (‘EUMI’, ‘E1MI’) and Output Elevation (50) as their 

default values.  With these settings, MsMicro will run at 50 m above ground and 
produce all the available microscale statistics, such as EUMI (mean wind speed) 
and E1MI (mean wind power). 

8. Using the Windows Explorer, create a new folder called TILES in your 
MyTutorial\MyMicro directory.  The microscale model outputs will be written there. 

9. For the MS Micro Output Tiles Directory parameter, use the Browse button  to 
select the TILES directory.   

10. The Output File (Merged Results) entry should be named MyMicroResults.fst, 
located in your MyTutorial\MyMicro directory.  

11. Uncheck the Run MsMicro box.  With this option turned off, MsMicro won’t be run 
by MMC, so we’ll be able to double-check the microgrid area before we run the 
model.  Click Apply to confirm the new settings. 

12. Click RunMMC.  Reply OK to the question. The TILES directory is empty at the 
moment, so there’s no data to be lost.  Save the MMC Name List File as 
MyMMC.nml in your MyMicro folder.   

13.  Let's check our layout before running MsMicro.  Once the first execution is done, 
open the microGrid.fst file (it’s located in the TILES\MMC_WORKING_DIR 
directory).  Load the ZERO and TI_I records. 

14. Drag ZERO to the 2D View.  ZERO must fit entirely within the MyMicroGEO MG 
domain.  

15. Since TI_I is a point set object defined in Lat/Long coordinates, change it to Polar 
Stereographic (60,-100) coordinates with the Apply button.  Drag it to the same 
view.  The TI_I points fall on the I1,I2 x J1,J2 mesoscale nodes.  The grid settings 
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look satisfactory. 
16. The only thing left now is to run MsMicro.  Check the Run MSMicro box in the 

MMC dialog. This enables various fields on the dialog. 
17. Set the Output File (Merged Results) to MyMicroResults.fst, located in your 

MyTutorial\MyMicro directory.  
18. Click Run MMC again.  The TILES directory will be overwritten. Answer OK to this 

question again. 
19. The execution will take between 5 and 10 minutes.  Once it’s done, open the output 

file MyTutorial\MyMicro\MyMicroResults.fst and load EUMI and E1MI.  Drag 
EUMI to the 2D View.  You can remove the TI_I, ZERO and MyMicroGrid objects 
from the View, if you’d like, but leave EU there. 

20. Change the Display parameters of EU in its Properties dialog.  Select Isolines as 
the Rendering Style, uncheck Monochrome and increase the Line Width to 3. 

21. Drag EU to the top of the 2D View.  Drag the Water object above the EUMI object 
as well.  Display your result as a surface (using the Display tab of the Properties 
dialog) and compare it with the screenshot shown above.  
The visual result can be improved by changing iso-levels on the Properties Dialog 
(ColourScale tab) of the EU and EUMI objects.  Try adjusting the settings until all 
of the information is clearly visible. 

22. Drag the E1MI object to a 2D View.  The map should look approximately as shown 
below, depending on your ColorScale selections.  The image below is shown with 
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its legend displayed.  

Validation of Your MMC Results 

By now, you should be able to compare your results, settings file, and log files with the 
reference files provided in [TutorialDir]\MMC\. 
If any of the results from MMC don’t appear to match the examples, double-check your 
parameters with the examples shown.  If that doesn’t clear up the problem, take a look 
at your WEStats results and your microscale terrain grid. 

Congratulations! 

You’ve completed the AnemoScope tutorial.  If you’ve followed all of the steps, you 
should now know how to scale down the supplied data to create a microscale wind map 
for any region in the world. 
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